



[image: ]
[bookmark: _Toc511220116][bookmark: _Toc523306278][bookmark: _Toc523477958][bookmark: _Toc523478411][image: C:\Users\ttsang.000\AppData\Local\Microsoft\Windows\INetCache\Content.Word\TAFE NSW NEW WARATAH LOCKUP NOV 2017 CMYK.png][image: M:\Graphic Design\[Alita]\_Other\Skillpoint Cover BG\Skillpoint bg lavender.jpg]
Student workbook
BSBWOR204
Use business technology 






	

	TAFE NSW – Western Sydney Region
Created: 29/10/2018
Version: 1.0
	Document5
Modified: 27/11/2019
Page 1 of 3




TAFE NSW would like to pay our respect and acknowledge Aboriginal and Torres Strait Islander Peoples as the Traditional Custodians of the Land, Rivers and Sea. We acknowledge and pay our respect to the Elders, both past and present of all Nations.








Version:			20180903
Date created:			01/11/2018
Date modified:		24/5/2019
For queries please contact:
Technology and Business Services SkillsPoint
TAFE Digital Learning and Content designers 

© NSW TAFE Commission 2018
RTO Provider Number 90003 | CRICOS Provider Code: 00591E
This resource can be found in the TAFE NSW Learning Bank.
The content in this document is copyright © NSW TAFE Commission 2018, and should not be reproduced without the permission of the TAFE NSW. Information contained in this document is correct at time of printing: 27 November 2019 . For current information please refer to our website or your teacher as appropriate.



Contents
Icon legends	5
Topic 1 Select and use technology	8
Introduction	8
Select technology and software applications	8
Office technology	9
Computer hardware	9
Printers	10
The computing process	11
The processing cycle	12
Software	14
Application software programs	15
Practice activity	16
Activity 1.1	16
Adjust workspace to meet ergonomic requirements	17
Lighting	17
Room temperature and ventilation	17
Health problems	17
Work breaks	17
Correct ergonomic practices	18
Benefits	19
Reduce fatigue	19
Work desk	19
Ergonomic exercises	20
Electrical cords and power supply	22
Noise	22
Ventilation and pollution	22
Practice activity	23
Activity 1.2	23
Using technology according to WHS standards	24
Operate technology correctly	24
Protecting information	25
Virus scan	25
Practice activity	26
Activity 1.3	26
Topic 2 Process and organise data	29
Introduction	29
Working with files and records	29
Graphical User Interface - Windows	29
Minimise, Restore Down or Maximise, and Close	29
Practice activity	30
Activity 2.1	30
Operate input devices	31
Mouse	31
Keyboard	31
Practice activity	32
Activity 2.2	32
Store data and exit applications	34
Hard disk drives	34
USB flash drive	34
Keeping track of computer files	35
Saving a document	37
Shutting Down	38
Practice activity	39
Activity 2.3	39
Use manuals, guides, and online help	41
Practice activity	41
Activity 2.4	41
Topic 3 – Maintain technology	44
Introduction	44
Identify and replace used technology consumables	44
Consider these points when ordering consumables	45
Practice activity	46
Activity 3.1	46
Carry out routine maintenance	47
Warranties	47
Service agreements	47
Other routine maintenance tasks	47
Cleaning equipment	48
Getting help	49
Practice activity	49
Activity 3.2	49
Identify equipment faults	50
Requisition and fault forms	50
Practice activity	51
Activity 3.3	51



[bookmark: _Toc518640492][bookmark: _Toc25753828]Icon legends
	Icons
	Descriptions
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	Practice activity 
Learning activities are the tasks and exercises that assist you in gaining a clear understanding of the content in this workbook.  It is important for you to undertake these activities, as they will enhance your learning.
Activities can be used to prepare you for assessments.  Refer to the assessments before you commence so that you are aware which activities will assist you in completing your assessments.
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	Collaboration 
Whether you discuss your learning in an online forum or in a face-to-face environment discussions allow you to create and consolidate new meaningful knowledge.
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	Self-check
A self-check is an activity that allows you to assess your own learning progress. It is an opportunity to determine the levels of your learning and to identify areas for improvement.
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	Readings (Required and suggested)
The required reading is referred to throughout this Student workbook. You will need the required text for readings and activities. 
The suggested reading is quoted in the Student workbook, however you do not need a copy of this text to complete the learning. The suggested reading provides supplementary information that may assist you in completing the unit.
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	Video
Links to videos will give you a deeper insight into subject matter discussed in this workbook. If you use the student workbook in a digital format you will be able to click on the link to the video. If you are working from a printed version you will need to look these up using the URL provided.



Introduction

This workbook will provide you with the skills and knowledge to select and use computer software and organise electronic information and data. It involves selecting and using the correct technology, processing and organising data and maintaining the technology in the workplace. It applies to individuals who apply a limited range of practical skills with a fundamental knowledge of equipment use and the organisation of data in a defined context, under direct supervision or with limited individual responsibility.
The information in this workbook relates to a broad range of business types and can be applied to a variety of projects or work tasks. You will find opportunities to apply your knowledge throughout by completing theory-based short answer activities. There is an extensive list of websites for further learning in the References section at the end of this workbook.




Topic 1
Select and use 
technology 
[bookmark: _Toc25753829]
Topic 1 Select and use technology 
[bookmark: _Toc21002938][bookmark: _Toc25753830]Introduction
In this topic you will:
· Select appropriate technology and software applications to achieve requirements of the task
· Adjust workspace, furniture and equipment to suit user’s ergonomic requirements
· Use technology according to organisational requirements and in a way that promotes a safe work environment

[bookmark: _Toc25753831]Select technology and software applications
The technology in your workplace will depend on the type of industry you work in and whether there is a need for specialised technology. Below is a list of general business technology for the many tasks performed in a workplace.
	· Photocopier	
	· Telephone and mobile phone

	· Computer system
	· Scanner

	· USB
	· External Drives

	· Binder
	· Digital Camera

	· Data Projector
	· Computer Networks (LAN and WAN)

	· Shredder
	· Voice-mail

	· Printer
	· Laminator

	· Internet
	· Smart Board





[bookmark: _Toc169969914][bookmark: _Toc25753832]Office technology
Most business office operations centre around commonly used technologies such as the computer and telephone system and multi-function printer.
[bookmark: _Toc25753833]Computer hardware
All the components which form a computer system are referred to as hardware. These are the physical parts of a computer system – the parts that you can see and touch. The basic computer hardware components are:
· System unit/tower
· Monitor
· Keyboard
· Mouse
· Printer
· Scanner
· Speakers

The hardware can be divided into four categories. 
1. An input device allows data to be entered into the computer, e.g. the mouse. 
2. An output device receives the results of the processed information, e.g. printer. 
3. A storage device saves the information, e.g. USB or external hard drive
4. A peripheral device is any hardware that is attached to a computer system e.g. printer, keyboard, scanner. 


[bookmark: _Toc25753834]Printers
Printers are the most commonly used peripheral hardware (output) device. There are two common types of printers: ink jet and laser.
Ink jet
Characters are formed by a series of tiny dots. A stream of ink drops are electrostatically sprayed on to the paper in the shape of the character(s) required. 
Laser 
A laser beam is used to produce characters on a photocopier-style drum.
Printers - advantages and disadvantages 
	Printer
	Advantages
	Disadvantages 

	Ink jet 
	Reasonably fast
Affordable
Can use coloured inks
Can use special papers (e.g. Photo (glossy), labels, envelopes
Recyclable cartridges
	Printouts can smudge when first printed
Ink cartridges are expensive

	Laser
	Very fast
Very quiet
Superior quality output
Can produce colour
Large range of printer fonts
Recyclable cartridges
	Very expensive
Toner cartridges are very expensive



[bookmark: _Toc169961620]Printer properties
[bookmark: _Toc169961621]Your computer’s Printers folder will give you several printing options, for example, add a Printer; Print a Test Page, Pause Printing, Purge the Print Queue etc.


[bookmark: _Toc25753835]The computing process
The Information Technology (IT) refers to the managing and processing of information using computers and associated technology. The computing process explains how this happens.
There are three main parts of the computing process:





[bookmark: _Toc25753836]The processing cycle
The diagram below displays the basic flow of data between the various input, process, storage and output devices:
Figure 1 The processing cycle © TAFENSW


[bookmark: _Toc528583153][bookmark: _Toc528583457][bookmark: _Toc528583563]










Booting up
Before any programs can be opened and work can be done the computer needs to be booted up. In other words, when you turn your computer on, you are ‘booting up’ and importantly the system software is loaded. The steps that are involved in this process are:













[bookmark: _Toc25753837]Software
Any hardware technology which is computerized is run by a software program. A program is actually the instructions which tell the computer how to operate and in what form to output the information. There are two categories of software.
System software, commonly known as the operating system, is the program which controls the computer, runs programs, and organises the information. This software is normally already loaded in your computer when it is purchased and it directs all the operations of the computer system. Example are Windows XP, Windows Vista and Windows 8. Without the system software the computer will not work. The operating system:
· ensures that the hardware (processor unit, printer, keyboard, mouse and other peripherals) work together harmoniously
· enables you to create and manages files and folders, view, move copy, names and delete files
· starts and runs applications software.
Application software is often called a ‘software package’. In relation to computers, these programs give instructions which determine the format in which information will be output (produced) by the computer. The following table shows various different software programs and their purpose available on your computers.

[bookmark: _Toc169078977][bookmark: _Toc25753838]Application software programs
	[image: Word]
Microsoft Word 2016
	Microsoft Word is a Word Processing program. It enables you to create professional-looking documents, such as letters, resumes, reports, etc.
File extension is .docx 

	[image: Microsoft Excel]
Microsoft Excel 2016
	Microsoft Excel is a Spreadsheet program. It makes calculations easy. Figures are changed on a worksheet, every total will change automatically. 
File extension is .xlsx

	[image: Access]
Microsoft Access 2016
	Microsoft Access is a Database Management System. Databases are collections of information, e.g. telephone directories and library catalogues. 
File extension is .accdb

	[image: PowerPoint]
Microsoft PowerPoint 2016
	PowerPoint is a Presentation Package which enables you to promote your company, ideas and information to an audience. This can be displayed on a computer screen, or a slide show using an overhead projector.
File extension is .pptx

	[image: Outlook]
Microsoft Outlook 2016
	E-mail is used for Communication. You can send, receive, reply and delete messages. The same message can be sent to many people. A file can be attached and sent with the e-mail.
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Microsoft Publisher 2016
	Publisher is special software used to create documents such as brochures, displays, booklets.
File extension is .pub

	[image: Image result for google chrome icon]


Google Chrome
	Allows you to view information on the Internet.

	[image: Image result for windows explorer icon]


Windows Explorer
	Allows configuration of the desktop, screen saver, file management.
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	[bookmark: _Toc25753839]Practice activity


[bookmark: _Toc25753840]Activity 1.1
1. The technology in your workplace will depend on the nature of the industry. 
Below is a list of equipment useful for the many tasks performed in a workplace. Briefly identify the purpose of each type of equipment. You may add your own that is relevant in your own workplace.
	Equipment
	Purpose

	Photocopier
	

	Telephone/mobile phone
	

	Digital Camera
	

	Shredder
	

	Scanner
	

	Data projector
	



2. Identify each item of computer equipment below, explain its purpose and check in the box to indicate if it is an input, output, process or storage device. 
	Equipment
	Purpose
	Input
	Output
	Process
	Storage Device

	Printer
	
	☐	☐	☐	☐
	USB
	
	☐	☐	☐	☐
	Keyboard
	
	☐	☐	☐	☐
	Monitor 
	
	☐	☐	☐	☐



[bookmark: _Toc25753841]Adjust workspace to meet ergonomic requirements 
[bookmark: Lighting][bookmark: _bookmark1][bookmark: _Toc529490550][bookmark: _Toc9430144][bookmark: _Toc25753842]Lighting
· Reduce glare, decorate rooms in pastel shades.
· Use blinds to prevent strong sunlight entering the room.
· Position your workstations away from windows to avoid reflections.
· Use combination of natural and fluorescent lighting.
[bookmark: Room_Temperature_and_Ventilation][bookmark: _bookmark2][bookmark: _Toc529490551][bookmark: _Toc9430145][bookmark: _Toc25753843]Room temperature and ventilation
· Maintain good ventilation in the office where you work.
· Make sure there is plenty of air flow around office equipment.
[bookmark: Health_Problems][bookmark: _bookmark3][bookmark: _Toc529490552][bookmark: _Toc9430146][bookmark: _Toc25753844]Health problems
· Avoid Occupational Overuse Syndrome (OOS) and Repetitive Strain Injury (RSI)—a range of conditions related to work injury, characterised by fatigue, aches and pain in the muscles, tendons and soft tissues.
· The risk factors for OOS or RSI are:
· Poor planning for VDU work (Visual Display Unit or monitor).
· Poor work organisation.
· Inappropriate selection of computer hardware and software.
· Inappropriate selection of office furniture.
· Inappropriate VDU environment.
· Poor workstation layout.
· Lack of education, training and skills.
[bookmark: _Toc529490553][bookmark: _Toc9430147][bookmark: _Toc25753845]Work breaks
· [bookmark: _bookmark4]Take 10 minutes break away from workstations every hour worked.
· Do simple work exercise during your break.
· [bookmark: Correct_Ergonomic_Practices][bookmark: _bookmark5]Vary your tasks i.e. filing, phone calls, etc.
[bookmark: _Toc529490554]

[bookmark: _Toc9430148][bookmark: _Toc25753846]Correct ergonomic practices
Ergonomics addresses the relationship of the human body to the workplace surroundings to produce and maintain an environment which reduces the impact of physical hazards.
A good place to start is to look at what problems might exist and then preventative measures which can be put in place.
[image: ]
Correct sitting posture by Shutterstock under license to TAFENSW
· Monitor – adjust distance and height: top of the monitor at eye-level and slightly tilted.
· Eye distance - must be between 45 - 70 cm from the screen.
· Arms – relax shoulders, forearms parallel to the floor. Minimal bend at the wrist
· Chair – should have a backrest and armrest, adjust height.
· Legs – thighs parallel to the floor.
· Feet – parallel to the floor, use a footrest if necessary.

Remember to take a break from your computer every 25 minutes.
Look at your desk and chair arrangement. Adjust your chair or table to suit your ergonomic requirements. In class, help out your neighbour by checking out their posture and work environment and adjust where necessary.
Ergonomics addresses the relationship of the human body to the workplace surroundings to produce and maintain an environment which reduces the impact of physical hazards.
A good place to start is to look at what problems might exist and then preventative measures which can be put in place.
[bookmark: _Toc25753847]Benefits
When attention is paid to the ergonomic design of a workplace there are many benefits, some of which are that:
· Work efficiency is increased
· Errors due to fatigue is decreased
· Health and injury problems are reduced
· Work satisfaction is increased 
[bookmark: _Toc25753848]Reduce fatigue
To reduce fatigue and reduce the risk of body injury and strain when using a computer:
· Adjust your chair and workstation
· Support your lower back with the back of the chair
· Place your feet flat on the floor
· Have your ankles, knees and hips at right angles
· Adjust the height of the desk so your elbows are at right angles to the keyboard
· If the desk height cannot be adjusted, a footrest may be used
· Clear the desk of all unnecessary materials
· Have regular rest breaks or rotate your tasks so you are not sitting at the computer for extended periods
· Gently stretch wrist, neck and shoulder muscles
[bookmark: _Toc25753849]Work desk
A height adjustable table is the best option, but not always available. You may need to improvise and use a footrest so that your feet and legs are prevented from being strained.


[bookmark: _Toc25753850]Ergonomic exercises
	[image: ]
	Watch


Video: Easy office stretches
This video demonstrates stretches for anyone who sits at a desk, works on a computer or uses a mobile phone.
[image: ]
27 November 2019 YouTube, Available at https://www.youtube.com/watch?v=_s41vuoPBwQ
[bookmark: _Toc9430152][bookmark: _Toc9430155]Chin tuck
· Pull chin in.
· Hold 2 seconds.
· Release.
· Repeat 10 times.
Hand stretch
· Drop arm.
· Clench fists for 1 second.
· Relax.
· Stretch fingers for 3 seconds.
· Repeat 5 times.
[bookmark: _Toc9430153]Forward wrist stretch
· Left elbow straight and in front of you at shoulder height.
· Bend left hand down and towards you with your right hand just below the wrist.
· Hold 10 seconds
· Repeat 3 times each arm.
[bookmark: _Toc9430154]Shoulder shrug
· Arms by your sides.
· Lift shoulders upwards—1 second.
· Move shoulders backwards—1 second.
· Relax shoulders—1 second.
· Repeat 10 times.
[bookmark: _Toc9430156]Neck stretch
· Right hand under right thigh.
· Left hand on your right ear.
· Gently pull your head to the left and slightly forward.
· Hold 10 seconds.
· Repeat 3 times each side.
[bookmark: _Toc9430157]Reaching
· Hold hands above head.
· Reach up with palms of hands upwards.
· Hold 10 seconds.
· Repeat 3 times.
[bookmark: _Toc9430158]Lower back stretch
· Stand feet slightly apart.
· Hands in the small of your back.
· Bend backwards—knees straight.
· Hold 2 seconds.
· Repeat 10 times.
Eyes
· Shut eyes for 3 seconds.
· Repeat 5 times.
· Look away for 5 seconds.
· Look at the screen for 3 seconds.
· Repeat 3 times.
[bookmark: _Toc25753851]Electrical cords and power supply
Power cords used for any technology must be situated away from passageways and traffic areas. Preferably, the technology should be positioned at the point outlet. 
Computers cords should be bundled together away from the floor area under the desk and connected to power boards and power outlets.

[bookmark: _Toc25753852]Noise
Where this is activity and a work environment, it is difficult not to have some level of noise. However, excessive noise is a hazard and can be disruptive by hindering concentration, causing stress and headaches. Any equipment which tends to be noisy in operation should if possible be separated from the main office by a divider, or placed in a separate area. 

[bookmark: _Toc25753853]Ventilation and pollution
Ventilation can be provided by air conditioning, or from open doors or open windows. It is important that there is a good air flow around any office technology to prevent the equipment overheating and to help maintain a comfortable temperature in the work environment. 
There is a certain amount of fume emission from both printers and photocopiers (from the toner chemicals used in the printing process). This equipment needs to be placed in a well ventilated area, near an open door or window, so that the fumes escape and pollution does not build up in the work area and become a health hazard.
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	Watch


[image: ]
27 November 2019 YouTube, Available at https://www.youtube.com/watch?v=T8qGO7XQ0Uw
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	[bookmark: _Toc25753854]Practice activity


[bookmark: _Toc25753855]Activity 1.2
1. Summarise the key points from the video.











[bookmark: _Toc25753856]Using technology according to WHS standards
Every workplace requires individuals to take responsibility for their safety. Follow organisational and legal requirements relating to WHS in the workplace. This includes:
· exercises, short breaks, rotation of duties to prevent RSI and eye strain
· employ correct manual handling techniques to prevent back strain
· set up your work area or computer work station to comply with sound ergonomic principles

[bookmark: _Toc25753857]Operate technology correctly
Technology used for saving information such as Disks, CDs, DVDs, USB drives need to be used carefully and according to manufacturer’s operational manual. As a rule keep them away from:
· Heat, cold 
· Dust, dirt 
· Moisture
· Smoke 
· Electromagnetic fields e.g. telephone, speakers, etc. 
· Do not place heavy objects on top
· Do not remove a USB flash drive device until it has been disengaged by clicking on the Safely Remove Hardware icon on the task bar.


[bookmark: _Toc25753858]Protecting information
Information can be lost or damaged in several ways. For example, through viruses, damage caused by thunderstorms, disk/USB damage, unauthorised access or accidental deletion of data.
Here are some precautionary measures which can be taken to protect information:
	Problem
	Prevention 

	Viruses (destructive program that can erase or damage files)
	Virus protection software (e.g. AVG)

	Thunderstorms
	Surge protection device

	Damaged USBs
	Backups i.e. emergency copies

	Unauthorised access
	Passwords, encryption

	Accidental deletion
	Write protect disk, ‘Read-Only’ protection

	Lost files
	Sensible and regular ‘housekeeping’ procedures



[bookmark: _Toc25753859]Virus scan
Scan your disk or USB before opening any files onto your computer. A virus is a destructive program which will cause havoc with your computer, its peripheral devices and the data. 
Information can be corrupted or lost, computer hardware can slow or stop altogether. Viruses most frequently enter your computer software through exposure to the internet and through emails. 
Anti-virus software loaded into your computer will enable viruses to be detected and cleaned from your computer. 


	[image: ]
	[bookmark: _Toc25753860]Practice activity


[bookmark: _Toc25753861]Activity 1.3
The following steps can be taken to run a virus scan at TAFE on your USB:
1. Insert your USB into the appropriate drive or port.
2. Click on File Explorer located on the task bar.
3. Right click on your USB device. 
4. Click on Scan on Windows Defender (depends on the version of Windows). 
5. Click on Cancel Scan
6. Click on Custom, then Scan Now. 
7. Select your USB, OK
8. Your disk or USB will be scanned for the existence of any virus or spyware.
9. When the scan is completed, the screen will indicate the presence of any virus.
10. Close the window if there is no virus or follow the screen directions if a virus is found.
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	[bookmark: _Toc518640502][bookmark: _Toc527638316]Self-check questions


[bookmark: _Toc7427338]How did you go? 
Check the boxes for the tasks you feel you could confidently complete. If you feel you are unable to tick any of the boxes, it might benefit to review the learning material.
☐	I feel confident to select the right piece of technology for the task.
☐	I can adjust my workspace to suit my ergonomic requirements.
☐	I can safely use technology in accordance with organisational requirements.




Topic 2
Process and 
organise data


[bookmark: _Toc25753862]Topic 2 Process and organise data
[bookmark: _Toc25753863]Introduction
In this topic you will:
· Identify, open, generate or amend files and records according to task and organisational requirements
· Operate input devices according to organisational requirements
· Store data appropriately and exit applications without damage to or loss of, data
· Use manuals, training booklets and/or online help or helpdesks to overcome basic difficulties with applications
[bookmark: _Toc25753864]Working with files and records
[bookmark: _Toc25753865]Graphical User Interface - Windows
Most computers work with Windows, a Graphical User Interface (GUI) which uses icons and menus to represent and locate features, functions and information in a program. One advantage of ‘Windows’ is that multiple program files can be open at the same time. 
[bookmark: _Toc169078973][bookmark: _Toc25753866]Minimise, Restore Down or Maximise, and Close
These buttons appear on all windows in the top right-hand corner.
1. Minimise – Reduces the main window to a button on the Taskbar. 
Click Taskbar button to return document to screen.
1. Restore Down – Makes the main window smaller than normal size.
1. Maximise – Click Maximise to return the smaller screen to normal size.
1. Close – Click Close button to close the document or program.
Figure 2 Screenshots of Minimise, Maximise, and Restore Down buttons
Restore Down
Close
Maximise
Close
Minimise
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	[bookmark: _Toc25753867]Practice activity


[bookmark: _Toc25753868]Activity 2.1
Open the following three programs, one after the other: Word, Paint & Excel.
	WORD
	PAINT
	EXCEL

	· Click on the Start Menu (bottom left hand corner of task bar) and look for MS Word 2016
· If not there, click in Ask me anything… type Word, and it will find Word. 
· Click on Blank Document to open Word
	· Click on the Start Menu again and look for Paint. 
· If not there, click in Ask me anything type Paint, and it will find Paint. 
· Click on Paint to open it.

	· Click on the Start Menu again and look for Excel. 
· If not there, click in Ask me anything… type Excel
· Click on Blank workbook and a workbook will be opened. 



· Resize all three programs so they appear as follows
MS Word
Program
MS Excel 
Program
Paint
Program
Minimise
Restore/Maximise 
Close 
Start Menu
Resize by dragging here

Figure 3 Screenshot of multiple programs open
· Resize the Word, Excel and Paint windows by dragging on the edges. 
· Practise using the Minimise and Restore/Maximise buttons
[bookmark: _Toc25753869][bookmark: _GoBack]Operate input devices 
[bookmark: _Toc25753870]Mouse
The mouse was designed to work with the graphic user interface environment of Windows – a user-friendly environment in which the computer operator points to and clicks on a word or a picture which represents a function or task to be performed. 
The mouse features, such as the appearance of the cursor when typing or moving a picture, can be modified by clicking on:
1. Start Menu 
1. Control Panel
1. Hardware and Sound
1. Devices and Printers
1. Mouse
[bookmark: _Toc25753871]Keyboard
The keyboard allows input of text and numeric data. It contains many function keys which when pressed perform specific tasks without using the mouse. For example, the F1 key is assigned on most computers to open the Help menu. Short cut key combinations are another feature of the keyboard and provide a fast and efficient method to performing many tasks in software programs. 
A short cut key usually involves pressing the Ctrl, Alt or Shift key, plus an alphabet key. 
For example, Ctrl + S saves the document, while Ctrl + C makes a copy of highlighted information. 
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	[bookmark: _Toc25753872]Practice activity


[bookmark: _Toc25753873]Activity 2.2
1. Open Microsoft Word
1. With the help function (Press F1)
1. Type in shortcut keys into the Search Option
1. Press Search
1. Locate the information for shortcut keys
1. Make a list of some short cut keys and their functions that you can use to enhance your word processing proficiency.
1. Compare your list with one of your classmates to see if you’ve missed any useful shortcuts.



	Short Cut Key
	Function

	Ctrl + O
	Open new document

	Ctrl + S
	Save a document

	
	

	
	

	
	

	
	

	
	

	
	

	
	

	
	

	
	

	
	

	
	

	
	






[bookmark: _Toc25753874]Store data and exit applications
[bookmark: _Toc25753875]Hard disk drives 
A hard disk drive is a device that stores data. Hard disk drives come in two major types: external and internal. Internal drives are housed inside the computers box or tower, while external drives are enclosed in their own housing outside of the computer. An internal drive will generally offer data higher transfer rates and will be powered by a direct internal connection to the computers power supply. An external hard drive will generally connect to the computer through a USB or FireWire port. One advantage of external hard drives is their portability, which allows the user to store or backup data from their computer onto the drive, take the drive to another computer system, connect it through a USB or fire wire port, and then access the stored data. 

[bookmark: _Toc25753876]USB flash drive 
Currently, USB flash drives are a good choice for portable secondary storage. USB flash drives can look like a thick pen, with one end in the form of a USB interface (connector). 
To use the USB flash drive, a user just plugs it into a USB port, at which point it can be accessed through the computers operating system interface.
USB flash drives have storage capacities ranging from tens of megabytes to several gigabytes. Also, flash drives can provide read access times that are faster than hard disk drives. However, current hard disk drives still far exceed USB flash drives in terms of storage capacity.


[bookmark: _Toc25753877]Keeping track of computer files
One of the main functions of your computer's operating system is to enable disk and file management. 
File management is often referred to as 'electronic filing' or simply 'housekeeping'. All these terms relate to the same thing, that is storing your information in an organised and well-managed filing system on your computer. 
One of the biggest advantages of electronic filing compared to manual filing is that you can store vast quantities of information in a minimal space. The tasks of sorting, naming, moving, copying, deleting, printing, renaming, updating can all be carried out by a computer system. 
[image: boxes on rack inside room]
Figure 4 Photo by Samuel Zeller on unsplash.com under Creative Commons CC0
How often should you perform 'File Management' tasks? 
File management tasks should be performed regularly, as you would routinely perform manual filing tasks. 
Many large companies have strict rules about File Management procedures in order to keep valuable information safe, up to date and easily accessible. These procedures should be regularly carried out both in the workplace and at home. 
[bookmark: _Toc169078981]

Folders
This is the term given to a collection of files in the computer or on a USB. If you looked at all the files on a USB, you would see the “directory” (or folder). Folders are used to put files into separate locations.
[bookmark: _Toc169078982][image: ]
Figure 5 screenshot of folder structure in Windows Explorer
File Explorer in Windows 10
File Explorer can be used to help manage your files.
1. Open File Explorer by clicking on the [image: ] icon on the task bar or right clicking the Start Menu button on the task bar. 
1. Click File Explorer.
1. Folders and/or files can be copied, moved or deleted using File Explorer.
1. You can create folders by clicking onto the New folder icon on the Home tab or by right clicking on your mouse and selecting New folder. 

Figure 6 screenshot of File Explorer ribbon
1. You can also rename a folder by selecting a folder, right clicking and selecting Rename. 


	[image: ]
	Watch


Video: Windows 10 – Create folders
This video demonstrates stretches for anyone who sits at a desk, works on a computer or uses a mobile phone.
[image: ]
27 November 2019 YouTube, Available at https://www.youtube.com/watch?v=9JCV8QO9180

[bookmark: _Toc25753878]Saving a document
When you have finished using a software application it is important that you save your files and close the application correctly. To save a file, generally you need to access the ‘File menu’ and then choose save or save as. The exact wording will depend on the application chosen. 
When you save your file, you need to consider the following:-
1. Where you want to save the file 
2. You may want to create a new folder for your file
3. What you want to name the file
4. What type of file you want to save it as (select an option from the list) 
Windows will not allow you to have two files with the same name in the same location, so if you save your file with the same name as an existing file in the same location (or folder) then this will be overwritten. 


Windows computers will allow you to use up to 256 characters in your file names. There are some characters that you are not allowed to use. These are known as reserved characters, which are shown below: 
	< (less than)
	: (colon)
	“ (double quote)

	\ (back slash)
	| (vertical bar)
	*(asterisk)

	>(greater than)
	? (question mark)
	/ (forward slash)



File naming conventions
When selecting a file naming protocol it should reflect the way you would normally sort or categorise the documents within the organisation. The components are separated by an underscore. 
A sample of a file naming convention is below: 
Agenda_31082019_v2.docx
Document Name
Date
Version Number 


Extension




[bookmark: _Toc25753879]Shutting Down
Shutting down means ending your computing session by exiting Windows and turning off.
It is important to shut down Windows correctly BEFORE turning off your computer. Failure to do this could damage your programs and files.
For a USB device, always click on the Desktop Task Bar icon Safely Remove Hardware. This ensure that the all files are closed and that the device is stopped before pulling it out from the port. 
For a CD or USB make sure that the green light in the drive or USB port is not on. Do not take out any storage device while the green light is showing, as you most probably will corrupt the information on the device.


	[image: ]
	[bookmark: _Toc25753880]Practice activity


[bookmark: _Toc25753881]Activity 2.3
Work through the following activities on your computer/device.
USB and file management 
Go to the Desktop screen
· Point to the MY COMPUTER icon and double click
Note: Drives and Folders are displayed on the left, folder contents are displayed on the right
Rename USB
1. Right click on your USB icon
2. Rename
3. Type your name as the label (or overtype any existing name) 
4. Press Enter
View file details 
1. Double click on USB icon
2. Click on the View menu (top left hand side of screen)
3. Select the Tiles icon (located on the Layout group
4. Name, Size, Date modified, Type, and size appear.
5. Adjust column widths
Sort file details
With Details displayed at the right-hand side of your screen –
1. Click once at the top of the Name column and notice that your files toggle between ascending order (alphabetical) and descending order.
2. Then click twice on Size and notice that the sizes reverse their order.
3. Then click twice on Modified and notice that the dates reverse their order


Print screen
1. Press PrtScn button on your keyboard (located next to your F12 button) or FN + Print Screen
1. Open a blank document in Word
1. Paste the picture of your screen by pressing Ctrl + V
CroppingFigure 7 screenshot of cropping tool

1. Select your picture
1. Click on the crop button located on the Format tab in the size group
1. Click on the cropping symbols (dark black line surroung the screen print) of your print screen and reduce the size of the picture 
Resizing
1. Click on your print screen and resize from the corners
Figure 8 screenshot of cropping process

Saving
1. Save the file on your USB to ensure you haven’t lost any data
Tile View
1. Click on View from the menu
1. Select the tiles icon
[image: ]


Figure 9 screenshot of tiles icon

[bookmark: _Toc169961642][bookmark: _Toc169969928][bookmark: _Toc435108024][bookmark: _Toc25753882]Use manuals, guides, and online help
All application software programs come with manuals, as well as a comprehensive in-built Help system. 
Many computer operators find that using the in-built Help system is a very fast way of gaining assistance during a task. 

	[image: ]
	[bookmark: _Toc25753883]Practice activity


[bookmark: _Toc25753884]Activity 2.4
[image: ]How to access HELP in MS Word 
1. Open MS Word
1. Press F1
1. In the Help Pane – Type your question here
1. Hit enter or click the magnifying glass icon to start searching
1. Choose the relevant topic from the search results 

Note: you can keep your HELP instructions displayed on screen at the same time as you perform each step in your document. You can also print them out if required. 



	[image: ]
	Self-check questions


How did you go? 
Check the boxes for the tasks you feel you could confidently complete. If you feel you are unable to tick any of the boxes, it might benefit to review the learning material.
☐	I can open, amend and save files without losing data.
☐	I can safely operate my input devices according to organisational requirements.
☐	I can use the online help or other manuals to overcome basic difficulties when using programs.





Topic 3
Maintain technology 
[bookmark: _Toc25753885]
Topic 3 – Maintain technology 
[bookmark: _Toc25753886]Introduction
In this topic you will:
· Identify and replace used technology consumables in accordance with manufacturer’s instructions and organisational requirements Operate input devices according to organisational requirements
· Carry out and/or arrange routine maintenance to ensure equipment is maintained in accordance with manufacturer’s instructions and organisational requirements 
· Identify equipment faults accurately and take action in accordance with manufacturer’s instructions or report fault to designated person 
[bookmark: _Toc25753887]Identify and replace used technology consumables
‘Consumables’ refers to the ‘consumer goods’ which are purchased separately for use with office equipment and which usually need to be replaced or ‘topped up’ from time to time. 
Without such consumables, the equipment would be useless. For example, an electricity supply and a light fitting would be useless without a light bulb.  A few examples of consumables are: Toner Cartridge, Headset, Paper and USB. 



[bookmark: _Toc25753888]Consider these points when ordering consumables
•	Check that the consumable is compatible with the equipment model number (this especially applies to printer cartridges).
•	If possible, shop around for the best price.
•	Consider buying recycled paper and cartridges.
•	Some cartridges can be refilled. In this case, check ink quality.
•	Remember, used paper should always be recycled.
•	Store paper supplies and cartridges in a cool, well ventilated place.
•	Store computer disks/USBs in appropriate boxes in a cool place.
•	Train staff in the economical use of consumables to save money.
•	Most offices appoint a particular member of staff to be in charge of consumables to ensure that supplies are always in stock, or are ordered if stocks run low.
•	As an equipment operator, remember to always tell an appropriate person if you have used the last ream of paper or ink cartridge, so that new stock can be quickly ordered.



	[image: ]
	Watch


Video: Replaces the toner cartriddge on HP Laser Jet Printers
This video demonstrates the correct method for replacing the toner cartridge on HP LaserJet printers.
[image: ]
27 November 2019 YouTube, Available at https://www.youtube.com/watch?v=HTLrZ0W9F58

	[image: ]
	[bookmark: _Toc25753889]Practice activity


[bookmark: _Toc25753890]Activity 3.1
Obtain the user manual for your printer and practice replacing used consumables ensuring you identify how to dispose of them in the correct manner.



[bookmark: _Toc25753891]Carry out routine maintenance
We will now look at routine maintenance of equipment with specific focus on computing hardware and peripherals. It should be noted however that much of the general information regarding routine maintenance can be applied to many other items of business equipment.
Operators have a responsibility to ensure that equipment is regularly checked, cleaned and maintained and, if necessary, repaired, not only to ensure continued productivity, but, more importantly, to optimise safety for themselves and their colleagues.
Organisational procedures will require that correct and up to date records are kept of the maintenance conducted on the equipment.
[bookmark: _Toc25753892]Warranties 
New items of equipment are generally covered by a supplier’s or manufacturer’s warranty. A warranty will ensure that any defects in materials and workmanship after the date of purchase will either be repaired or replaced without charge during the warranty period. 
It is wise to read the warranty terms closely to fully understand what will and will not be covered by warranty. For example, warranty does not cover improper or inadequate maintenance or unauthorised modification or repair. 
[bookmark: _Toc25753893]Service agreements
In some instances, you can also pay a fee to suppliers to have a preventive maintenance check carried out regularly. Such maintenance would include cleaning, lubrication and replacement of worn-out or defective parts. 
[bookmark: _Toc25753894]Other routine maintenance tasks
· Regular ‘Housekeeping’– This involves deleting obsolete files, creating folders and renaming files
· Regular backups - Security procedure to protect data on a computer or computer network. It involves copying files and folders onto a device that can be store away from the computer. If the computer became lost or damaged, the information contained in the backup can be load onto a new computer
· Virus scanning – You need to have software that will protect your data from viruses, worms and Trojan horse programs (allows hacker to access your computer from a remote location
· Regular password changes – Usually every 3 months
· Disk clean-up - Removes unnecessary files that could be taking up space on your hard disk.
[bookmark: _Toc25753895]Cleaning equipment
Cleaning is an important routine maintenance task. There is a wide range of cleaning products available today, specially manufactured for computer hardware and peripherals which do not use harsh or abrasive chemicals. 
It is important to remember that you are cleaning electrical equipment so do not use or spray any liquids onto the equipment. There is a high risk of electrocution and of damage to the electronic circuitry of the equipment. Refer to WHS guidelines and manufacturers manuals for correct procedure in cleaning equipment.
See below for some suggestions for safe cleaning of computer hardware:
	Generic Product
	Purpose
	How it works 

	Dust covers
	Monitor, keyboard, printer, mouse, scanner
	Made of a water repellant, anti-static vinyl which protects from damaging static, dust, dirt and spills

	Cleaning cloths 
	All items of hardware -screens, CD and DVD media, camera lenses and scanner glass
	Often made of microfibre with electrostatic charge to attract dust mites. For cleaning and polishing without scratching.

	Disposable wipes
	As above
	Contain electrostatic charge for cleaning and removing dust mites.

	Laser printer cleaning sheets
	Laser printers
	Sheets that feed through the paper path, like a document. They should be fed through after changing a toner or following a big copy output. 

	Compressed air sprays
	Keyboard and other equipment
	Moisture free dust removing spray which is also ozone safe

	Vacuum cleaner/blower
	Computer, peripherals and desk 
	Includes a flexible hose to reach into tiny areas and usually comes with disposable paper bags.

	Cable organiser
	Computer leads and cables
	A PVC, tube-like cover which holds multiple cables and cords together, thus keeping them tidy and less likely to trip people up 


[bookmark: _Toc25753896]Getting help
When you have checked the obvious things and still cannot resolve the problem, you could:
· Check the Manufacturer’s User Manual (some manuals have a Troubleshooting section)
· Ask other operators in your office for their assistance
· Ring for technical phone support, e.g. some problems can be ‘fixed’ over the telephone without the need for an on-site visit


	[image: ]
	[bookmark: _Toc25753897]Practice activity


[bookmark: _Toc25753898]Activity 3.2
In the event of any of the items of equipment below being inoperable, what could you check first, before calling a technician?
	Equipment
	Aspect to check

	Monitor
	

	Keyboard
	

	Mouse
	

	Printer
	

	Scanner
	



[bookmark: _Toc25753899]
Identify equipment faults
In the event that a problem occurs that cannot be fixed, and a technician needs to be called, all details of the problem should be noted. A technician will require the following information: 
· Equipment make and model number
· Serial number
· Full description of problem 
· Location of equipment and contact person’s name (this information is often kept on file) 
· Check if equipment should be taken to the supplier for attention or if a technician will come to your office. 
[bookmark: _Toc25753900]Requisition and fault forms
When a technician is called, two procedures must be attended to:
1. Complete a Maintenance Requisition Report
1. Enter all details of the faulty equipment into an Equipment Register
The Maintenance Requisition Report should be faxed to the supplier and a copy kept on file.
The equipment register should be kept in your office. 


Example below of a Maintenance Requisition Report 
	Maintenance Requisition Report

	Department
	Marketing Dept.
	Req. No.
	72

	Contact Officer
	Nancy Song
	Phone No. 
	9350 3232

	Approving Officer
	Nathan Daniels
	Date 
	6 Jan 20XX

	Equipment
	Pentium Computer 
	Make/Model No.
	Premier ZN 71
(S982134-9)

	Location
	123 Same Street, Sydney NSW – Room 421 

	Details of Fault
	Cannot get to the desktop. Screen is blue with columns of green writing all over it.
Have checked all connections.

	SECTION BELOW TO BE FILLED IN BY MAINTENANCE TECHNICIAN

	Technician
	
	Signature
	

	Date/Time Out 
	
	Date/Time Completed
	

	Comments (if applicable)

	Materials Used 



	[image: ]
	[bookmark: _Toc25753901]Practice activity


[bookmark: _Toc25753902]Activity 3.3
Obtain the equipment fault register for your organisation and familiarise yourself with it so you can fill it in in the case of equipment failures.


Input
Data is entered into a device using a mouse, keyboard or other device


Process
The input data is processed by the CPU (Central Processing Unit). The CPU can request information from storgae devices (memory, hard/disk drives).


Output
Once the data has been processed the result is displayed on a monitor and or/printed.











Process


Input


Disk Drives


Output


Memory

















The boot program loads the operating system into main memory.


The operating system then loads system configuration information, which basically tells the computer how to communicate with each device, e.g. keyboard, mouse, CD-ROM drive, scanner etc. 


The remainder of the operating system is loaded and the desktop and icons will be displayed on screen. The computer is now ready for you to use. 
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